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产品特点

1. 支持 GSM/GPRS/EDGE四频和WCDMA/HSPA三频；

2. 支持 2个网络连接同时在线，支持 TCP和 UDP；
3. 支持发送网络注册包；

4. 支持发送心跳包数据，可发向网络或串口。

5. 支持远程短信设置模块参数；

6. 支持多种工作模式：短信透传模式、网络透传模式、HTTPD模式；

7. 支持简单指令发送中文/英文短信，避免了 PDU发送中文短信复杂难用；

8. 支持类 RFC2217功能，可从网络动态修改模块的串口参数；

9. 支持 RS232/RS485（二选一使用）。
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1. 产品概述

1.1. 产品简介

USR-G761w 是一款适用于 WCDMA网络制式的 3G DTU 产品，工作于 WCDMA/GSM 通信网络，支持

HSDPA(7.2Mbps)高速下行传输，和 HSUPA(5.76Mbps)高速上行传输。以“透传”作为功能核心，高度易用性，

用户可方便快速的集成于自己的系统中，实现基于WCDMA网络的数据传输。

表 1 基本参数

项目 指标

无线参数

工作频段

GSM/GPRS/EDGE Quad-band:

GSM850MHz

EGSM900MHz

DCS1800MHz

PCS1900MHz

WCDMA/HSPA Tri-band:

BAND1:2100MHz

BAND2:1900MHz

BAND5:850MHz

接收灵敏度

GSM850 <-108.5dBm

EGSM900 <-108.5dBm

DCS1800 <-108.7dBm

PCS1900 <-108.7dBm

GSM850 33dBm±2dB

EGSM900 33dBm±2dB

DCS1800 30dBm±2dB

最大发射功率

PCS1900 30dBm±2dB

GSM850(8PSK) 27dBm±3dB

EGSM900(8PSK) 27dBm±3dB

DCS1800(8PSK) 26dBm±3dB

PCS1900(8PSK) 26dBm±3dB

WCDMA 2100 24dBm±1/-3dB

WCDMA 1900 24dBm±1/-3dB

WCAMA 850 24dBm±1/-3dB

数据带宽 下行：7.2Mbps 上行：5.76Mbps

硬件参数
数据接口

RS232：1200bps - 460800bps

RS485：1200bps - 460800bps

工作电压 DC 5V~24V

工作电流 平均电流 200mA@12V，峰值电流 230mA@12V

http://h.usr.cn
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工作温度 -35℃~80℃

存储温度 -45℃~90℃

尺寸 103 x 105 x 28（mm）

软件参数
工作模式 透明传输模式，串口指令模式

设置命令 AT+命令结构

用户配置方式 设置软件

软件功能

域名解析 DNS 支持

简单透传方式 支持 TCP client /UDP Client

HTTP 协议传输 支持

短信透传 支持

心跳数据包 支持

类 RFC2217 支持

注册包机制 支持自定义、ICCID、IMEI、透传云

http://h.usr.cn
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2. 产品功能

图 1 功能框图

2.1. 工作模式

共有 3种工作模式：短信透传模式，网络透传模式，HTTPD Client模式。

 网络透传模式
在此模式下，用户的串口设备，可以通过本模块发送数据到网络上指定的服务器。模块也可以接受来自服

务器的数据，并将信息转发至串口设备。

 HTTPD模式
在此模式下，用户的串口设备，可以通过本模块发送请求数据到指定的 HTTP服务器，然后模块接收来自

HTTP服务器的数据，对数据进行解析并将结果发至串口设备。

 短信透传模式
在此模式下，用户的串口设备，可以发送短信到指定的手机上，也可以接受来自任何手机发来的短信息，

并将信息转发至串口设备。
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2.1.1. 网络透传模式

图 2 网络透传模式示意图

在此模式下，用户的串口设备，可以通过本设备发送数据到网络上指定的服务器。设备也可以接受来自服

务器的数据，并将信息转发至串口设备。一次发送数据的最大长度由打包长度决定，参考 AT+UARTFL。
G761w支持两路 socket同时连接，分别为 socket A 和 socket B，它们是相互独立的。本设备支持仅支持

作为 TCP Client和 UDP Client。

AT指令设置方法：

1. 设置工作模式为网络透传：

AT+WKMOD=NET

2. 设置 socket A为使能状态：

AT+SOCKAEN=ON

3. 设置 socket A为 TCP Client：
AT+SOCKA=TCP,test.usr.cn,2317

4. 设置 socket A为长连接：

AT+SOCKASL=LONG

5. 重启：

AT+Z

http://h.usr.cn
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使用软件工具设置：

图 3 设置软件示意图

1. 打开专用设置软件“USR-G76x”。根据实际情况设置串口参数并点击“打开串口”。

2. 点击“进入配置状态”，等待设备进入 AT指令配置模式。

3. 点击“获取当前参数”，等待获取所有当前参数完毕。

4. 在“选择工作模式”一栏中，选中“网络透传模式”。

5. 设置“地址和端口”为 test.usr.cn和 2317。设置“连接类型”为 TCP和长连接。

6. 点击“设置并保存所有参数”。

7. 保存完毕后，点击“重启按钮”重启设备，或者给设备断电再上电即可。
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2.1.2. HTTPD Client模式

图 4 HTTPD Client模式示意图

HTTPD功能是什么？

用事先设置好请求的服务器地址与端口、请求方式和包头等信息。用户设备向 DTU发送请求数据，DTU
根据 HTTP协议对数据进行组包处理后，将请求包发给 HTTP服务器。HTTP服务器返回结果给 DTU，DTU
将结果解析成用户设备所需要的格式，发送给用户设备。

由于串口接收缓存为 1000字节，所以 DTU组包后的包大小最多 1000字节。

用户想实现串口设备向 HTTP服务器请求数据，但是串口设备所在的地方，不方便通过路由器接入因特网，

但是有基站信号，这样就可以采用 G761w为串口设备和 HTTP服务器搭起一座通信的桥梁。

AT指令设置方法：

1. 设置工作模式为 HTTPD：
AT+WKMOD=HTTPD

2. 设置 HTTP的请求方式：

AT+HTPTP=GET

3. 设置 HTTP的请求 URL：
AT+HTPURL=/1.php[3F]

4. 设置 HTTP的请求服务器：

http://h.usr.cn
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AT+HTPSV=test.usr.cn,80

5. 设置 HTTP的请求头信息：

AT+HTPHD=Connection: close[0D][0A]

6. 设置 HTTP的请求超时时间：

AT+HTPTO=10

7. 设置是否过滤回复信息包头：

AT+HTPFLT=ON

8. 重启：

AT+Z

使用软件工具设置：

图 5 设置软件示意图

1. 打开专用设置软件“USR-G76x”。根据实际情况设置串口参数并点击“打开串口”。

2. 点击“获取当前参数”，等待获取所有当前参数完毕。

3. 点击“进入配置状态”，等待设备进入 AT指令配置模式。

4. 在“选择工作模式”一栏中，选中“HTTPD模式”。

5. 设置 “HTTP 请求方式 ”为 GET。设置 “HTTP 请求的 URL”为 “/1.php[3F]”。设置 “服务器地址 ”为

http://h.usr.cn
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“www.usr.cn”。设置“服务器端口”为80，设置“超时时间”为10秒。设置“HTTP请求头信息”为“Connection:
Keep-Alive[0D][0A]”，选中“过滤 HTTP头信息”。

6. 点击“设置并保存所有参数”。

7. 保存完毕后，点击“重启按钮”重启设备，或者给设备断电再上电即可。

http://h.usr.cn
http://www.usr.cn


USR-G761w 软件设计手册 http://h.usr.cn

济南有人物联网技术有限公司 www.usr.cn第 12 页 共 51 页

2.1.3. 短信透传模式

图 6 短息透传模式示意图

每条短息最多支持 140个 ASCII码或 70个汉字。短信息发送频率不宜过高，可根据实际测试情况来决定。

用户不需要关注串口数据与短信息之间的数据转换过程，只需通过简单的参数设置，即可实现手机与串口

设备之间的数据透明通信。

使用 AT指令设置：

1. 设置工作模式为短信透传模式：

AT+WKMOD=SMS

2. 设置指定的手机号码为目标：

AT+DSTNUM=15866668888

3. 设置过滤短信来源电话号码：

AT+SMSFLT=ON

4. 重启：

AT+Z
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使用软件工具设置：

图 7 设置软件示意图

1. 打开专用设置软件“USR-G76x”。根据实际情况设置串口参数并点击“打开串口”。

2. 点击“进入配置状态”，等待设备进入 AT指令配置模式。

3. 点击“获取当前参数”，等待获取所有当前参数完毕。

4. 在“选择工作模式”一栏中，选中“短信透传模式”。

5. 设置“透传目标电话号码”为 15866668888，勾选“过滤短信来源号码”。

6. 点击“设置并保存所有参数”。

7. 保存完毕后，点击“重启按钮”重启设备，或者给设备断电再上电即可。
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2.2. 串口

2.2.1. 基本参数

表 2 串口基本参数

项目 参数

波特率
1200，2400，4800，9600，14400，19200，38400，

57600，115200，128000，230400，460800
数据位 7,8
停止位 1,2

校验位

NONE（无校验位）

EVEN（偶校验）

ODD（奇校验）

SPACE（0校验）

流控/485
NFC：无硬件流控

485:485通信

2.2.2. 成帧机制

2.2.2.1. 时间触发模式

G761w在接收来自 UART的数据时，会不断的检查相邻 2个字节的间隔时间。如果间隔时间大于等于某

一“时间阈值”，则认为一帧结束，否则一直接收数据直到大于等于 1K字节。将这一帧数据作为一个 TCP或 UDP
包发向网络端。这里的“时间阈值”即为打包间隔时间。可设置的范围是 10ms~60000ms。出厂默认 200ms。

这个参数可以根据 AT命令来设置，AT+UARTFT=<time>。

图 8 时间触发模式

2.2.2.2. 长度触发模式

G761w在接收来自 UART的数据时，会不断的检查已接收到的字节数。如果已接收到的字节数某一“长度

阈值”，则认为一帧结束。将这一帧数据作为一个 TCP或 UDP包发向网络端。这里的“长度阈值”即为打包长度。

可设置的范围是 1~1000。出厂默认 1000。
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这个参数可以根据 AT命令来设置，AT+UARTFL=<length>。

图 9 长度触发模式

2.2.3. 类 RFC2217

图 10 类 RFC2217功能示意图

此功能类似于 RFC2217，即从网络端动态修改串口参数。从网络端发送符合特定协议的数据， 即可实时

修改串口的参数，这种修改只是临时性的，模块重启后，恢复原来的参数。

http://h.usr.cn
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协议说明

协议长度为 8个字节，具体协议内容如下，举例的数值为 HEX格式：

表 3 类 RFC2217协议

名称 包头 波特率 位数参数 和校验

字节数 3 3 1 1

说明
三个字节减少

误判

三个字节表示一

个波特率值，高

位在前

不同的 bit来表示不

同的含义，见附表

前面四位的和

校验，忽略进位

举例

(115200,N,8,1)
55 AA 55 01 C2 00 83 46

举例

(9600,N,8,1)
55 AA 55 00 25 80 83 28

表 4 串口参数位 bit含义说明

位号 说明 值 描述

1:0 数据位选择

00 5位数据位

01 6位数据位

10 7位数据位

11 8位数据位

2 停止位
0 1位停止位

1 2位停止位

3 校验位使能
0 不使能校验位

1 使能检验位

5:4 校验位类型

00 ODD奇校验

01 EVEN偶校验

10 Mark置一

7:6 无定义 00 请写 0

http://h.usr.cn
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2.3. 特色功能

2.3.1. 注册包功能

图 11 注册包功能示意图

注册包是指在 G761w 发送网络透传数据时，增加一些附加信息，来实现一些特殊的功能。这些附加信息会在

建立网络连接（TCP连接）时，或是将其插入到数据包的最前端作为数据包的一部分。

注册包的类型有 ICCID、IMEI、CLOUD和 USER。
 ICCID，SIM的唯一识别码，适用于基于 SIM卡识别的应用。

 IMEI，DTU设备内上网模块的唯一识别码，适用于基于设备识别的应用，与其内安装的 SIM卡无关。

 CLOUD，基于有人透传云应用的识别码，通过设置的已获取权限的相关参数，即可轻松使用有人透传云服

务。

 USER，用户自定义数据，可应用于用户自定义的注册数据。

表 5 参考 AT指令集

指令名称 指令功能 默认参数

AT+ REGEN 查询/设置是否使能注册包 OFF
AT+ REGTP 查询/设置注册包内容类型 USER
AT+ REGDT 查询/设置自定义注册信息 7777772E7573722E636E

http://h.usr.cn
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AT+ REGSND 查询/设置注册包发送方式 DATA

1. 开启注册包功能：

AT+ REGEN=ON

2. 设置注册包内容类型为用户自定义：

AT+ REGTP=USER

3. 设置自定义注册包数据：

AT+REGDT=7777772E7573722E636E

4. 设置注册包发送方式为将注册数据作为每包数据的头：

AT+ REGSND=DATA

5. 重启：

AT+ Z

设置软件示意图：

图 12 设置软件示意图

1. 打开专用设置软件“USR-G76x”。根据实际情况设置串口参数并点击“打开串口”。

2. 点击“获取当前参数”，等待获取所有当前参数完毕。

3. 点击“进入配置状态”，等待设备进入 AT指令配置模式。

http://h.usr.cn
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4. 在“选择工作模式”一栏中，选中“网络透传模式”并设置 socketA的参数。

5. 开启注册包功能，并设置各项参数。

6. 点击“设置并保存所有参数”。

7. 保存完毕后，点击“重启按钮”重启设备，或者给设备断电再上电即可。

2.3.2. 心跳包功能

图 13 心跳包功能示意图

在网络透传模式下，用户可以选择让设备发送心跳包。心跳包可以向网络服务器端发送，也可以向串口设

备端发送。

向网络端发送主要目的是为了与服务器保持连接，和让长时间空闲（很长时间内不会向服务器发送数据）

的设备与服务器端的连接。

在服务器向设备发送固定查询指令的应用中，为了减少通信流量，用户可以选择，用向串口设备端发送心

跳包（查询指令），来代替从服务器发送查询指令。

表 6 参考 AT指令集

指令名称 指令功能 默认参数

AT+ HEARTEN 查询/设置是否使能心跳包 OFF
AT+ HEARTDT 查询/设置心跳包数据 7777772E7573722E636E
AT+ HEARTTP 查询/设置心跳包的发送方式 NET
AT+ HEARTTM 查询/设置心跳包发送间隔 30

1. 开启心跳包功能：

AT+ HEARTEN=ON

2. 设置心跳包数据：

AT+ HEARTDT=7777772E7573722E636E
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3. 设置心跳包发送方式为发向网络端：

AT+ HEARTTP=NET

4. 设置心跳包的发送间隔时间：

AT+ HEARTTM=30

5. 重启：

AT+ Z

设置软件示意图：

图 14 设置软件示意图

1. 打开专用设置软件“USR-G76x”。根据实际情况设置串口参数并点击“打开串口”。

2. 点击“获取当前参数”，等待获取所有当前参数完毕。

3. 点击“进入配置状态”，等待设备进入 AT指令配置模式。

4. 在“选择工作模式”一栏中，选中“网络透传模式”

5. 设置 socketA的参数。

6. 开启心跳包功能，并设置各项参数。

7. 点击“设置并保存所有参数”。
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8. 保存完毕后，点击“重启按钮”重启设备，或者给设备断电再上电即可。

2.3.3. 状态指示灯

G761w的状态指示灯有 POWER、WORK、STA、LINKA、LINKB。
 POWER，指示设备的供电是否正常。正常时常亮，异常时不亮。

 WORK，指示设备是否正常工作。正常时闪烁（1Hz），异常时不亮。

 STA，指示设备内的联网 DTU工作状态，如下表所示。

表 7 STA状态说明

电平状态 含义

35ms高/500ms低 模块未在网

70ms高/1000ms低 模块已在网

23ms高/333ms低 模块通过 2G网络传输数据

11ms高/163ms低 模块通过 3G网络传输数据

 LINKA，指示 socket A的连接状态，连接时常亮，断开时不亮。

 LINKB，指示 socket B的连接状态，连接时常亮，断开时不亮。

2.3.4. 硬件恢复默认设置

恢复用户默认参数，上电后，按下 Reload键 3~15S，然后松开，即可将设备参数恢复至用户默认参数。

2.3.5. 固件升级方法

1. 和 FAE或技术支持同事索要软件“FlashTool.zip”，解压后打开文件“Flash_tool.exe”。
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图 15 升级软件示意图

2. 设置下载波特率，在菜单栏上，选择“Options→Baudrate→961200”。
3. 设置下载串口号，在菜单栏上，选择“Options→Com port→COM7”。根据实际的串口号选择。

4. 选择固件文件，点击按钮“Scatter/Config File”，在弹出的窗口内选择程序文件夹内的.CFG文件如下

图所示，

图 16 升级软件示意图
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5. 设置下载选项，点击按钮“Options”，在弹出的窗口内选择“Backup->Download/Format->Restore”，
如下图所示，（一定要选择此项，否则将丢失射频校准参数）。

图 17 升级软件示意图

6. 点击按钮“Download”，给设备重新上电，即可进入下载过程，等待下载完成，如下图。

图 18 升级软件示意图
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3. 参数设置

3.1. 串口配置

3.1.1. 设置软件说明

图 19 设置软件示意图

说明：

1. 软件串口参数设置区，需设置与 DTU当前串口一致的参数，否则无法与 DTU通信。

2. 工作模式选择区，选择 DTU工作与哪种模式。

3. 特色功能参数设置区，设置 DTU特色功能相关的参数。

4. 全局参数区，设置 DTU基本的全局参数。

5. 指令发送按钮，点击可发送自输入的指令。

6. 输入框，自输入指令文本框。

7. 接收框，接收来自 DTU返回信息。

8. 常用指令按钮，点击可输入常用的 AT指令。
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3.1.2. AT指令设置

当设备工作在短信透传模式、网络透传模式、HTTPD Client模式三种工作模式的任何一种时，可以通过向

设备的串口发送特定时序的数据，让设备切换至“AT指令模式”。也可以通过发送特定指令让设备重新返回之前

的工作模式。

图 20 模式切换时序图

在上图中，横轴为时间轴，时间轴上方的数据是串口设备发给设备的，时间轴下方的数据为设备发给串口

的。

时间要求：

T1 > 当前串口打包间隔时间（参考 AT+UARTFT）
T2 < 当前串口打包间隔时间（参考 AT+UARTFT）
T3 < 当前串口打包间隔时间（参考 AT+UARTFT）
T5 < 3s

从短信透传模式、网络透传模式、HTTPD Client模式切换至“AT指令模式”的时序：

 串口设备给设备连续发送“+++”，设备收到“+++”后，会给设备发送一个‘a’。
在发送“+++”之前的 200ms内不可发送任何数据。

 当设备接收‘a’后，必须在 3秒内给设备发送一个‘a’。
 设备在接收到‘a’后，给设备发送“+ok”，并进入“临时指令模式”。
 设备接收到“+ok”后，知道设备已进入“临时指令模式”，可以向其发送 AT指令。

从 AT指令模式切换至短信透传、网络透传、HTTPD的时序：

 串口设备给设备发送指令“AT+ENTM”。
 设备在接收到指令后，给设备发送“OK”，并回到之前的工作模式。

 设备接收到“OK”后，知道设备已回到之前的工作模式。
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3.1.3. 串口 AT指令

串口 AT指令是指工作在透传模式下，我们不需要切换到指令模式，可以使用密码加 AT指令方法去查

询和设置参数的方法。以查询固件版本号为例，发送 AT指令。注：此处 AT指令中的回车符用[0D]表
示，实际使用中请输入正确的字符。

图 21 设置软件示意图

查询当前的密码字，查询/设置指令为 AT+CMDPW
通过软件可以看到当前的命令密码是：www.usr.cn#

完成设置后，重启模块，启动完毕后，从串口向模块发送 www.usr.cn#AT+VER（注意该字符串最后

有一个回车符），模块接收后，会返回指令响应信息。

图 22 设置软件示意图

http://h.usr.cn
http://www.usr.cn


USR-G761w 软件设计手册 http://h.usr.cn

济南有人物联网技术有限公司 www.usr.cn第 27 页 共 51 页

3.1.4. 网络 AT指令

网络 AT指令是指工作在透传模式下，通过网络发送密码加 AT指令的方式去设置和查询参数。以查

询固件版本号为例，发送 AT指令。注：此处 AT指令中的回车符用[0D]表示，实际使用中请输入正确的字

符。

图 23 设置软件示意图

查询当前的密码字，查询/设置指令为 AT+CMDPW

通过软件可以看到当前的命令密码是：www.usr.cn#

除了做以上设置外，还要对网络连接如 socket A 和 socket B的设置。完成设置后，重启模块，启动

完毕后，等待模块连接服务器，连接成功后，从服务器端向模块发送 www.usr.cn#AT+VER（注意该

字符串最后有一个回车符），模块接收后，会返回响应信息。如下图：
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图 24 设置软件示意图

3.1.5. 短信 AT指令

短信 AT指令是指，我们可以使用短信的方式去查询和我配置模块的参数，以查询固件版本号为例，发送

AT指令。注：此处 AT指令中的回车符用[0D]表示，实际使用中请输入正确的字符。

查询当前的密码字，查询/设置指令为 AT+CMDPW

图 25 设置软件示意图

完成设置后，重启模块，启动完毕后，从手机端向模块发送“www.usr.cn#AT+VER”，模块接收后，会返回

响应信息如下图
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图 26 手机短信息界面示意图

3.1.6. 指令格式

AT指令为“问答式”指令，分为“问”和“答”两部分。“问”是指设备向设备发送 AT命令，“答”是指设备给设备回

复信息。

注：指令中的字符不区分大小写。

3.1.6.1. 符号说明

表 8 符号说明

符号名称 含义

<> 被包括的内容为必需项

[] 被包括的内容为非必需项

{} 被包括的内容为此文档中特殊含义的字符串

~ 参数范围，例 A~B，参数的范围是从 A到 B
CMD 表示指令码

OP 表示操作符
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PARA 表示参数

CR 表示 ASCII码中的“回车符”，十六进制数表示为 0x0D
LF 表示 ASCII码中的“换行符”，十六进制数表示为 0x0A

3.1.6.2. 指令中“问”的格式

指令串：<AT+>[CMD][OP][PARA]<CR>
表 9 符号说明

命令码 含义 是否是必需项

AT+ AT命令头 是

CMD 指令的功能属性 是

OP 操作符，如=，?，=? 否

PARA 执行的参数 否

CR 回车，命令结束符 是

指令类型说明：

表 10 符号说明

类型 指令串格式 说明

0 <AT+><CMD>?<CR> 执行该指令的动作或查询当前参数值

1 <AT+><CMD>=?<CR> 查询该指令中的参数的取值范围或类型

2 <AT+><CMD><CR> 执行该指令的动作或查询当前参数值

3 <AT+><CMD>=<PARA><CR> 设置该指令的参数值

3.1.6.3. 指令中“答”的格式

注：指令的响应信息分为有回显和无回显两种，回显的含义是在输入指令的时候，把输入的内容返回来，

然后再对该指令做出响应。无回显则是不会返回输入的内容，只对指令做出响应。在以下说明中，均以无回显

模式为例。

命令串：[CR][LF][+CMD][OP][PARA][CR][LF]<CR><LF>[OK]<CR><LF>

表 11 符号说明

命令码 含义 是否是必需项

CR 回车符 否

LF 换行符 否

+CMD 响应头 否

OP 操作符，如 : 否

PARA 返回的参数 否

CR 回车符 否
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LF 换行符 否

CR 回车符 是

LF 换行符 是

OK 表示操作成功 否

CR 回车符 是

LF 换行符 是

响应指令类型说明

表 12 符号说明

类型 指令串格式 说明

0 <CR><LF><OK><CR><LF> 返回该指令成功

1 <CR><LF><+CMD:><PARA><CR><LF><CR><LF><OK><CR><LF> 返回当前参数

3.1.6.4. 特殊符号说明：

在 AT指令中，等号（=）、逗号（,）、问号(?)、回车、换行都是特殊符号，所以参数中不可直接包含等

号、逗号、问号。需要对其进行转义。

转义规则：用[]把特殊符号的十六进制编码括起来，表示输入一个十六进制编码表示的 ASCII码。

举例：问号(?)的十六进制编码是 0x3F，用此转义方法转义后表示为[3F]。
常用转义字符：

符号 含义 转义码

= 等于号 [3D]
, 逗号 [2C]
? 问号 [3F]

<CR> 回车符 [0D]
<LF> 换行符 [0A]

3.1.7. AT指令集

表 13 AT指令集

指令 功能描述

管理指令

AT 测试指令

H 帮助信息

Z 设备重启

E 查询/设置是否开启指令回显

ENTM 退出命令模式

WKMOD 查询/设置工作模式

CMDPW 查询/设置命令密码

STMSG 查询/设置设备启动信息

CSQ 查询设备当前信号强度信息

配置参数指令

RELD 恢复用户默认设置
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CLEAR 恢复原始出厂设置

CFGTF 将当前设置保存为默认设置

信息查询指令

VER 查询版本信息

SN 查询 SN码

ICCID 查询 ICCID码

IMEI 查询 IMEI码
串口参数指令

UART 查询/设置串口参数

UARTFT 查询/设置串口打包间隔时间

UARTFL 查询/设置串口打包数据长度

RFCEN 查询/设置是否使能类 RFC2217功能

网络指令

APN 查询/设置 APN信息

SOCKA 查询/设置 socket A参数

SOCKB 查询/设置 socket B参数

SOCKAEN 查询/设置是否使能 socket A
SOCKBEN 查询/设置是否使能 socket B
SOCKASL 查询/设置是否使能 socket A短连接

SOCKBSL 查询/设置是否使能 socket B短连接

SOCKALK 查询 socket A连接状态

SOCKBLK 查询 socket B连接状态

SOCKATO 查询/设置 socket A短连接超时时间

SOCKBTO 查询/设置 socket B短连接超时时间

SOCKIND 查询/设置是否使能指示透传数据来源 socket
注册包指令

REGEN 查询/设置是否使能注册包

REGTP 查询/设置注册包内容类型

REGDT 查询/设置自定义注册信息

REGSND 查询/设置注册包发送方式

CLOUD 查询/设置透传云注册参数

心跳包指令

HEARTEN 查询/设置是否使能心跳包

HEARTDT 查询/设置心跳包数据

HEARTSND 查询/设置心跳包的发送方式

HEARTTM 查询/设置心跳包发送间隔

HTTPD指令

HTPTP 查询/设置 HTTP工作方式

HTPURL 查询/设置 URL
HTPSV 查询/设置目标服务器地址和端口

HTPHD 查询/设置 HTTP协议 HEAD信息

HTPTO 查询/设置超时时间

HTPFLT 查询/设置是否使能过滤包头
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短信息指令

DSTNUM 目标电话号码

SMSEND 发送短信息

CISMSSEND 发送短信息

SMSFLT 查询/设置是否过滤短信息来源电话号码

SMSPH 查询/设置是否显示短信息来源电话号码

3.1.7.1. AT

 功能：测试指令，用于测试当前设备是否处于活动状态。

 格式：

 查询：

AT{CR}
{CR}{LF}OK{CR}{LF}{CR}{LF}OK{CR}{LF}

3.1.7.2. AT+H

 功能：帮助指令。

 格式：

 查询：

AT+H{CR}
{CR}{LF}help message{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：
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 help message：指令帮助说明。

3.1.7.3. AT+Z

 功能：重启设备。

 格式：

AT+Z{CR}
{CR}{LF}OK{CR}{LF}

3.1.7.4. AT+E

 功能：查询/设置设备 AT指令的回显状态。

 格式：

 查询当前参数值：

AT+E{CR}或 AT+E?{CR}
{CR}{LF}+E:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+E=status{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 status：回显状态，包括：

 ON：开启

 OFF：关闭

 例：AT+E=ON

3.1.7.5. AT+ENTM

 功能：设置设备返回之前的工作模式。

 格式：

 执行指定功能：

AT+ENTM{CR}
{CR}{LF}OK{CR}{LF}

3.1.7.6. AT+WKMOD

 功能：查询/设置设备的工作模式。

 格式：

 查询当前参数值：

AT+WKMOD{CR}或 AT+WKMOD?{CR}
{CR}{LF}+WKMOD:mode{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+WKMOD=mode{CR}
{CR}{LF}OK{CR}{LF}

http://h.usr.cn
http://www.usr.cn


USR-G761w 软件设计手册 http://h.usr.cn

济南有人物联网技术有限公司 www.usr.cn第 35 页 共 51 页

 参数：

 mode：工作模式，包括：

 SMS：短信透传模式

 NET：网络透传模式

 HTTPD：HTTPD模式

 例：AT+WKMOD=NET

3.1.7.7. AT+CMDPW

 功能：查询/设置命令密码。

 格式：

 查询当前参数值：

AT+CMDPW{CR}或 AT+CMDPW?{CR}
{CR}{LF}+CMDPW:password{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+CMDPW=password{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 password：命令密码，1~10个字节的 ASCII码。

 例：AT+CMDPW=www.usr.cn#

3.1.7.8. AT+STMSG

 功能：查询/设置设备的欢迎信息。

 格式：

 查询当前参数值：

AT+STMSG{CR}或 AT+STMSG?{CR}
{CR}{LF}+STMSG:message{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+STMSG=message{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 message：欢迎信息，设备上电启动后，主动输出的信息。1~20字节的 ASCII码。

 例：AT+STMSG=www.usr.cn

3.1.7.9. AT+CSQ

 功能：查询设备当前信号强度信息。

 格式：

 查询当前参数值：

AT+CSQ{CR}或 AT+CSQ?{CR}
{CR}{LF}+CSQ: rssi,ber {CR}{LF}{CR}{LF}OK{CR}{LF}
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 参数：

 rssi：接收信号强度指示

 0，等于或小于-125 dBm
 1~30，取整(31×（125－|rssi|）/ 50) dBm
 31，等于或大于-75 dBm
 99，未知或不可测

 ber：（比特误码率百分比）：暂时不支持 BER 查询，在 Execution 命令和 Test命令均返回 99。

3.1.7.10. AT+RELD

 功能：恢复用户默认设置，设备会重启。

 格式：

 执行指定功能：

AT+RELD{CR}
{CR}{LF}OK{CR}{LF}

3.1.7.11. AT+CLEAR

 功能：恢复出厂设置，设备会重启。

 格式：

 执行指定功能：

AT+CLEAR{CR}
{CR}{LF}OK{CR}{LF}

3.1.7.12. AT+CFGTF

 功能：将设备当前的运行参数保存为默认参数。

 格式：

 执行指定功能：

AT+CFGTF{CR}
{CR}{LF}OK{CR}{LF}

3.1.7.13. AT+VER

 功能：查询设备的固件版本。

 格式：

 查询当前参数值：

AT+VER{CR}或 AT+VER?{CR}
{CR}{LF}+VER:version{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：

 version：固件版本号。
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3.1.7.14. AT+SN

 功能：查询设备的 SN码。

 格式：

 查询当前参数值：

AT+SN{CR}或 AT+SN?{CR}
{CR}{LF}+SN:code{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：

 code：SN码

3.1.7.15. AT+ICCID

 功能：查询设备的 ICCID码。

 格式：

 查询当前参数值：

AT+ICCID{CR}或 AT+ICCID?{CR}
{CR}{LF}+ICCID:code{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：

 code：ICCID码。

3.1.7.16. AT+IMEI

 功能：查询设备的 IMEI码。

 格式：

 查询当前参数值：

AT+IMEI{CR}或 AT+IMEI?{CR}
{CR}{LF}+IMEI:code{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：

 code：IMEI码。

3.1.7.17. AT+UART

 功能：查询/设置串口参数。

 格式：

AT+UART{CR}或 AT+UART?{CR}
{CR}{LF}+UART:baud,data bit,stop bit,parity,flow control{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+UART=baud,data bit,stop bit,parity,flow control{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 baud：波特率，1200~460800范围内的连续值。

 data bit：数据位，包括：
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 7：7位数据

 8：8位数据

 stop bit：停止位，包括：

 1：1位数据

 2：2位数据

 parity：校验方式，包括：

 NONE：无校验

 ODD：奇校验

 EVEN：偶校验

 flow control：流控，包括：

 NFC：无流控

 RS485：使用 RS485功能

 例：AT+UART=115200,8,1,NONE,NFC

3.1.7.18. AT+UARTFT

 功能：查询/设置串口打包间隔时间。

 格式：

AT+UARTFT{CR}或 AT+UARTFT?{CR}
{CR}{LF}+UARTFT:time{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+UARTFT=time{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 time：打包间隔时间，范围是 50~60000ms。
 例：AT+UARTFT=200

3.1.7.19. AT+UARTFL

 功能：查询/设置串口打包长度。

 格式：

AT+UARTFL{CR}或 AT+UARTFL?{CR}
{CR}{LF}+UARTFL:length{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+UARTFL=length{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 length：打包长度，范围是 1~1000字节。

 例：AT+ UARTFL =1000

3.1.7.20. AT+RFCEN

 功能：查询/设置是否使能类 RFC2217功能。
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 格式：

 查询当前参数值：

AT+RFCEN{CR}或 AT+RFCEN?{CR}
{CR}{LF}+RFCEN:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+RFCEN=status{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 status：类 RFC2217 功能使能状态，包括：

 ON：使能

 OFF：禁止

 例：AT+RFCEN=ON

3.1.7.21. AT+APN

 功能：查询/设置 APN码。

 格式：

 查询当前参数值：

AT+APN{CR}或 AT+APN?{CR}
{CR}{LF}+APN:code,user_name,password{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+APN=code,user_name,password{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 code：APN
 user_name：用户名

 password：密码

 例：AT+APN=3gnet

3.1.7.22. AT+SOCKA

 功能：查询/设置 socket A的参数。

 格式：

 查询当前参数值：

AT+SOCKA{CR}或 AT+SOCKA?{CR}
{CR}{LF}+SOCKA:protocol,address,port{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SOCKA=protocol,address,port{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 protocol：通信协议，包括：

 TCP：TCP协议

 UDP：UDP协议
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 address：服务器地址，此地址可以域名或 IP。
 port：服务器端口，范围 1~65535。

 例：AT+SOCKA=TCP,test.usr.cn,8899

3.1.7.23. AT+SOCKB

 功能：查询/设置 socket B的参数。

 格式：

 查询当前参数值：

AT+SOCKB{CR}或 AT+SOCKB?{CR}
{CR}{LF}+SOCKB:protocol,address,port{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SOCKB=protocol,address,port{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 protocol：通信协议，包括：

 TCP：TCP协议

 UDP：UDP协议

 address：服务器地址，此地址可以域名或 IP。
 port：服务器端口，范围 1~65535。

 例：AT+SOCKB=TCP,test.usr.cn,8899

3.1.7.24. AT+SOCKAEN

 功能：查询/设置是否使能 socket A。
 格式：

 查询当前参数值：

AT+SOCKAEN{CR}或 AT+SOCKAEN?{CR}
{CR}{LF}+SOCKAEN:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SOCKAEN=status{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 status：socket A功能使能状态，包括：

 ON：使能

 OFF：禁止

3.1.7.25. AT+SOCKBEN

 功能：查询/设置是否使能 socket B。
 格式：

 查询当前参数值：

AT+SOCKBEN{CR}或 AT+SOCKBEN?{CR}
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{CR}{LF}+SOCKBEN:status{CR}{LF}{CR}{LF}OK{CR}{LF}
 设置：

AT+SOCKBEN=status{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 status：socket B功能使能状态，包括：

 ON：使能

 OFF：禁止

3.1.7.26. AT+SOCKASL

 功能：查询/设置 socket A用于 TCP通信时的连接方式。

 格式：

 查询当前参数值：

AT+SOCKASL{CR}或 AT+SOCKASL?{CR}
{CR}{LF}+SOCKASL:type{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SOCKASL=type{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 type：连接方式，包括：

 SHORT：短连接

 LONG：长连接

 例：AT+SOCKASL=LONG

3.1.7.27. AT+SOCKBSL

 功能：查询/设置 socket B用于 TCP通信时的连接方式。

 格式：

 查询当前参数值：

AT+SOCKBSL{CR}或 AT+SOCKBSL?{CR}
{CR}{LF}+SOCKBSL:type{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SOCKBSL=type{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 type：连接方式，包括：

 SHORT：短连接

 LONG：长连接

 例：AT+SOCKBSL=LONG
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3.1.7.28. AT+SOCKALK

 功能：查询 socket A是否已建立连接。

 格式：

 查询当前参数值：

AT+SOCKALK{CR}或 AT+SOCKALK?{CR}
{CR}{LF}+SOCKALK:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：

 status：socket A连接状态，包括：

 ON：已连接

 OFF：未连接

3.1.7.29. AT+SOCKBLK

 功能：查询 socket B是否已建立连接。

 格式：

 查询当前参数值：

AT+SOCKBLK{CR}或 AT+SOCKBLK?{CR}
{CR}{LF}+SOCKBLK:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：

 status：socket B连接状态，包括：

 ON：已连接

 OFF：未连接

3.1.7.30. AT+SOCKATO

 功能：查询/设置 socket A短连接的超时时间。

 格式：

 查询当前参数值：

AT+SOCKATO{CR}或 AT+SOCKATO?{CR}
{CR}{LF}+SOCKATO:time{CR}{LF}{CR}{LF}OK{CR}{LF}

 参数：

 time：socket A短连接超时时间，可设置范围是 1~100S。
 例：AT+SOCKATO=10

3.1.7.31. AT+SOCKBTO

 功能：查询/设置 socket B短连接的超时时间。

 格式：

 查询当前参数值：

AT+SOCKBTO{CR}或 AT+SOCKBTO?{CR}
{CR}{LF}+SOCKBTO:time{CR}{LF}{CR}{LF}OK{CR}{LF}
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 参数：

 time：socket B短连接超时时间，可设置范围是 1~100S。

3.1.7.32. AT+SOCKIND

 功能：查询/设置是否使能指示透传数据来源 socket。
 格式：

 查询当前参数值：

AT+SOCKIND{CR}或 AT+SOCKIND?{CR}
{CR}{LF}+SOCKIND:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SOCKIND=status{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 status：指示透传数据来源 socket功能使能状态，包括：

 ON：开启

 OFF：关闭

3.1.7.33. AT+REGEN

 功能：查询/设置是否使能注册包功能。

 格式：

 查询当前参数值：

AT+REGEN{CR}或 AT+REGEN?{CR}
{CR}{LF}+REGEN:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+REGEN=status{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 status：注册包功能使能状态，包括：

 ON：开启

 OFF：关闭

3.1.7.34. AT+REGTP

 功能：查询/设置注册包的内容类型。

 格式：

 查询当前参数值：

AT+REGTP{CR}或 AT+REGTP?{CR}
{CR}{LF}+REGTP:type{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+REGTP=type{CR}
{CR}{LF}OK{CR}{LF}
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 参数：

 type：注册数据类型，包括：

 ICCID：ICCID码

 IMEI：IMEI码
 D2DID：D2D功能的注册 ID
 CLOUD：透传云功能

 USER：用户自定义

 例：AT+ REGTP = ICCID

3.1.7.35. AT+REGDT

 功能：查询/设置自定义注册包数据。

 格式：

 查询当前参数值：

AT+REGDT{CR}或 AT+REGDT?{CR}
{CR}{LF}+REGDT:data{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+REGDT=data{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 data：用户自定义注册包数据 ,十六进制字符串格式，最大长度 80 字节。例如：参数值为

7777772E7573722E636E，如果用 ASCII码表示则为www.usr.cn
 例：AT+ REGDT = 7777772E7573722E636E

3.1.7.36. AT+REGSND

 功能：查询/设置注册包的发送方式。

 格式：

 查询当前参数值：

AT+REGSND{CR}或 AT+REGSND?{CR}
{CR}{LF}+REGSND:type{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+REGSND=type{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 type：发送方式，包括：

 LINK：建立连接时发送

 DATA：注册包数据作为每包数据的开头

 例：AT+ REGSND = DATA

3.1.7.37. AT+CLOUD

 功能：查询/设置有人透传云功能的注册参数。
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 格式：

 查询当前参数值：

AT+CLOUD{CR}或 AT+CLOUD?{CR}
{CR}{LF}+CLOUD:id,password{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+CLOUD=id,password{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 id：有人透传云功能的注册 ID，长度是 20个字节。

 password：有人透传云功能的通信密码，长度是 8个字节。

 例：AT+ CLOUD = 12345678901234567890,12345678

3.1.7.38. AT+HEARTEN

 功能：查询/设置是否使能心跳包功能。

 格式：

 查询当前参数值：

AT+HEARTEN{CR}或 AT+HEARTEN?{CR}
{CR}{LF}+HEARTEN:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HEARTEN=status{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 status：心跳包功能使能状态，包括：

 ON：开启

 OFF：关闭

3.1.7.39. AT+HEARTDT

 功能：查询/设置心跳包数据。

 格式：

 查询当前参数值：

AT+HEARTDT{CR}或 AT+HEARTDT?{CR}
{CR}{LF}+HEARTDT:data{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HEARTDT=data{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 data：心跳包数据，十六进制字符串，2~80偶数个字节，例如：参数值为”7777772E7573722E636E”，
如果用 ASCII码表示则为www.usr.cn

 例：AT+ HEARTDT = 7777772E7573722E636E
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3.1.7.40. AT+HEARTSND

 功能：查询/设置心跳包的发送方式。

 格式：

 查询当前参数值：

AT+HEARTSND{CR}或 AT+HEARTSND?{CR}
{CR}{LF}+HEARTSND:type{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HEARTSND=type{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 type：发送方式，包括：

 COM：向串口端发送心跳包

 NET：向网络端发送心跳包

 例：AT+ HEARTSND = COM

3.1.7.41. AT+HEARTTM

 功能：查询/设置心跳包的发送间隔时间。

 格式：

 查询当前参数值：

AT+HEARTTM{CR}或 AT+HEARTTM?{CR}
{CR}{LF}+HEARTTM:time{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HEARTTM=time{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 time：送间隔时间，可设置范围是 1~6000S。
 例：AT+ HEARTTM = 30

3.1.7.42. AT+HTPTP

 功能：查询/设置 HTTP请求方式。

 格式：

 查询当前参数值：

AT+HTPTP{CR}或 AT+HTPTP?{CR}
{CR}{LF}+HTPTP:type{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HTPTP=type{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 type：HTTP请求方式，包括：

 GET：get方式
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 POST：post方式

 例：AT+ HTPTP = POST

3.1.7.43. AT+HTPURL

 功能：查询/设置 HTTP请求的 URL。
 格式：

 查询当前参数值：

AT+HTPURL{CR}或 AT+HTPURL?{CR}
{CR}{LF}+HTPURL:URL{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HTPURL=URL{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 URL：HTTP请求的 URL，例如/1.php[3F]，转义规则请参考《特殊符号说明》章节。

 例：AT+ HTPURL = /1.php[3F]

3.1.7.44. AT+HTPSV

 功能：查询/设置 HTTP请求的服务器参数。

 格式：

 查询当前参数值：

AT+HTPSV{CR}或 AT+HTPSV?{CR}
{CR}{LF}+HTPSV:address,port{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HTPSV=address,port{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 address：服务器地址，此地址可以域名或 IP。
 port：服务器端口，可设置范围是 1~65535。

 例：AT+ HTPSV = test.usr.cn,80

3.1.7.45. AT+HTPHD

功能：查询/设置 HTTP请求的头信息。

格式：

 查询当前参数值：

AT+HTPHD{CR}或 AT+HTPHD?{CR}
{CR}{LF}+HTPHD:head{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HTPHD=head{CR}
{CR}{LF}OK{CR}{LF}

参数：
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 head：HTTP请求的头信息。例如 Connection: close[0D][0A]，必须以[0D][0A]结尾，转义规则请参

考《特殊符号说明》章节。

 例：AT+ HTPHD = Connection: close[0D][0A]

3.1.7.46. AT+HTPTO

功能：查询/设置 HTTP请求的超时时间。

格式：

 查询当前参数值：

AT+HTPTO{CR}或 AT+HTPTO?{CR}
{CR}{LF}+HTPTO:time{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HTPTO=time{CR}
{CR}{LF}OK{CR}{LF}

参数：

 head：HTTP请求的超时时间，可设置范围是 1~600S。
 例：AT+ HTPTO = 10

3.1.7.47. AT+HTPFLT

功能：查询/设置是否过滤 HTTP请求回复信息的头信息。

格式：

 查询当前参数值：

AT+HTPFLT{CR}或 AT+HTPFLT?{CR}
{CR}{LF}+HTPFLT:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+HTPFLT=status{CR}
{CR}{LF}OK{CR}{LF}

参数：

 status：是否过滤 HTTP请求回复信息的头信息。

 ON：开启

 OFF：关闭

3.1.7.48. AT+DSTNUM

 功能：查询/设置短信息的目标电话号码。

 格式：

 查询当前参数值：

AT+DSTNUM{CR}或 AT+DSTNUM?{CR}
{CR}{LF}+DSTNUM:number{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+DSTNUM=number{CR}
{CR}{LF}OK{CR}{LF}
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 参数：

 number：短信透传功能中的目标电话号码

 例：AT+ DSTNUM = 13066666666

3.1.7.49. AT+SMSEND

 功能：发送短信息。

 格式：

 设置：

AT+SMSEND=number,type,data{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 number：短信息的目标电话号码

 type: 编码方式，包括

 1：7Bits编码，无压缩

 3：UCS8，中英文方式

 data：短信息的内容

 例：AT+ SMSEND = 10086,3,你好啊

3.1.7.50. AT+CISMSSEND

 功能：发送短信息。

 格式：

 设置：

AT+CISMSSEND=number,type,data{CR}
{CR}{LF}OK{CR}{LF}

 参数：

 number：短信息的目标电话号码

 type: 编码方式，包括

 1：7Bits编码，无压缩

 3：UCS8，中英文方式

 data：短信息的内容

 例：AT+ CISMSSEND = 10083,3,你好啊

3.1.7.51. AT+SMSFLT

功能：查询/设置是否过滤短信息来源电话号码。

格式：

 查询当前参数值：

AT+SMSFLT{CR}或 AT+SMSFLT?{CR}
{CR}{LF}+SMSFLT:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SMSFLT=status{CR}
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{CR}{LF}OK{CR}{LF}
参数：

 status：是否过滤短信息来源电话号码。

 ON：开启

 OFF：关闭

3.1.7.52. AT+SMSPH

功能：查询/设置是否显示短信息来源电话号码。

格式：

 查询当前参数值：

AT+SMSPH{CR}或 AT+SMSPH?{CR}
{CR}{LF}+SMSPH:status{CR}{LF}{CR}{LF}OK{CR}{LF}

 设置：

AT+SMSPH=status{CR}
{CR}{LF}OK{CR}{LF}

参数：

 status：是否显示短信息来源电话号码。

 ON：开启

 OFF：关闭

4. 联系方式

公 司：济南有人物联网技术有限公司

地 址：山东省济南市高新区新泺大街 1166号奥盛大厦 1号楼 11层

网 址：http://www.usr.cn

客户支持中心：http://h.usr.cn

邮 箱：sales@usr.cn

企 业QQ：8000 25565

电 话：4000-255-652 或者 0531-88826739

有人愿景：国内联网通讯第一品牌

公司文化：有人在认真做事!
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产品理念：简单 可靠 价格合理

有人信条：天道酬勤 厚德载物 共同成长

5. 免责声明

本文档提供有关 USR-G761w 系列产品的信息，本文档未授予任何知识产权的许可，并未以明示或暗示，

或以禁止发言或其它方式授予任何知识产权许可。除在其产品的销售条款和条件声明的责任之外, 我公司概不

承担任何其它责任。并且，我公司对本产品的销售和/或使用不作任何明示或暗示的担保，包括对产品的特定用

途适用性，适销性或对任何专利权，版权或其它知识产权的侵权责任等均不作担保。本公司可能随时对产品规

格及产品描述做出修改，恕不另行通知。

6. 更新历史

2016-08-05 版本 V1.0.1 建立

2016-08-19 版本 V1.0.2 测试组审核，修改基本参数注册包功能。

2016-08-19 版本 V1.0.3 FAE审核，修改部分名称错误。

2016-08-25 版本 V1.0.4 技术经理审核，修改部分图片错误。

2016-10-25 版本 V1.0.5 修改升级方法。
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